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1 General 

1.1 About this document 

This document gives a detailed description of how the graphical station in FirstOpNet is configured 
and used.  

1.2 Operative system 

The client software is tested to work with the following versions of MicroSoft Windows: 
 

• Windows XP 
• Windows 7 
• Windows 8 
• Windows 10 

 
Installations have also been done for Windows  Embedded used within industrial PCs with touch 
screen.  In this case some Windows components might be added for the software to work. Contact 
First Control for more information. 

1.3 Program rights and responsibilities 

All the software that is included in FirstOpNet is the property of First Control Systems AB and must not 
be used in any other way than is specified in the License conditions. This means for instance that the 
software may not be copied, installed or spread to another party which is not explicitly defined in the 
License conditions.  Moreover, First Control Systems AB takes no responsibility whatsoever for any 
technical or economical consequence of how the software is used in the specific installation. 

1.4 Revision historic 

Nr Datum Commentary  Ref 
1 2017-12-01 Manual FirstOpNet English version 1  GB 
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2 Introduction 

First Operator Net – as easy as it can be ! 
          

 

 
 

   
DCS system for kallvalsverk 

  
DCS  

 
 
 
 
 
 

 

Modular design to be used by everybody! 
The FirstOPNet graphical station is a unique operator platform which can be configured by any control 
engineer without special software skills. It is based on First Controls experience of control systems in 
several disciplines and in a close cooperation with customers. For example, we have reused the 
experience from PLC systems where programming must be done safely when the system is running. 
Our experience from controlling many difficult processes has given us the insight how to generate 
high-quality production data based on statistical methods. 
 
The station can be used as an advanced graphical station in research projects with the XC05 control 
system (PLC) which accepts Modelica simulation models , as a stand-alone operator station for a single 
process or as a local client in a distributed scada network (FirstOPNet). 

 

Highlights 

 
� Easy configuration techniques which can be used by any control engineer without special 

programming skills. There is thus no need for special system programming or compilations. 

� All design is made in the running station which is a huge advantage for the user since he will 
directly see the effects of what he is doing. This means that everything is visible directly after 
it is done and that the station is working also during a design stage. 

� A powerful object library for any type of normal animation. The customer may also build his 
own face plate library to interface his process objects. 

� Production data is generated by statistical methods (SPC) which analyze data at high speed 
down to a few msec if needed. This means that all process changes will always be included in 
the production data. 

� Production replay function means that the whole internal database is continuously stored in 
local compressed files down to a few msec if needed. This means that all actions in the station 
can be retrieved in detail also several months afterwards. In a rolling mill installation we could 
replay the situation in detail down to 50 msec in all production during two years. 

� A distributed FirstOpNet scada network can be configured by the user himself. The operator 
windows may be shared by all other clients connected to a common file server which contains 
a library of all windows used in the network. 
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3 Scada components (optional) 

3.1 Factory network 

This information is only used when the FirstOp station is a part of a scada network installation 
 
 
Factory network 
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A full size FirstOpNet DCS system consists of a number of different system 
components or building blocks that works together as soon they are 
installed and configured:  
 

• FirstOpNet Client  
Operator station  for direct communication between operator and 
process 

• FileServer  
Central server which contains a library of operator windows Which 
are constructed somewhere in the network and can be shared by 
other stations.  

• SignalServer  

Central server which communicates all real time data between 
clients and control system.  

• AlarmServer  
Central SQL server that stores alarms which are generated 
somewhere in the production network. 

• SignalServer Backup 

Central server for redundant protection of data transfer in the 
production network with automatic switch at system failure 

• SignalServer Public 

Central signalserver for external clients which are not part of 
production. 

• Protocol Server  
Handles data exchange with the control system. Besides  
FirstControl’s standard server  MCProt for MicroController XC 
systems, there are various  servers for standard communication as 
e.g. Modbus TCP, FreeLance, MelsecNet etc. 

• OPC Server/Client  

General  communication with other systems according to the OPC 
standard. 

• Production database 
Central SQL server for storage of  historical production data which 
is generated somewhere in the network 

• SPC Logger. 

SPC logger handles statistical data transfer between  local  clients 
and the  central SQL server.  The production data is stored in local 
backup files until transfer is made. 

File  
server 

Signal  
server 

SQL  
logger 

Alarm  
server 
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3.2 Signal server  

   
 

 
 
The main tasks of the Signal server are: 
 

1. Communicating signal values and operator inputs between clients. Each operator command 
which is activated in another client somewhere in the network are sent to the sources client 
which executes the command if external commands are allowed (see database settings in 
chapter 5) 

2. Makes sure the database in a client is updated if changes are made in the sources database. 
All data which exists in shared operator windows in a client are automatically updated in the 
local database of the client if a change is made in the source database.  

3. Information about connected clients are displayed including communication status and data 
transfer speed (expand the window to the right). 

 
The signals server must be running if communication between operator clients is to work. At failure in 
the communication network, the local operator clients directly connected to the control system can 
still be operated in the normal way and no data get lost.  
 
In order to increase the safety in the network, it is also possible to install a Backup server which 
automatically takes over if the normal signal server does not work. For external clients there is also a 
Public server which makes the client a passive member, i.e. can not affect the basic network.   
 
Comments on operator command over the network 
At distant commands, it is very important that the command is protected and reaches the correct 
object in the network. This is handled by the signal server which receives the operator command and 
directs it to the right source with binary coded data. By the property ”Global” in the database setting 
you can also block some operator commands which require local presence, e.g. reset of a local safety 
system or startup of  a sensitive process part. 
  

Display of sources for signal 
data from connected operator 
clients  

Display of all connected 
operator clients. By expanding 
the windows to the right you 
can also see the current 
communication speed in the 
network.  

All events in the server are 
saved. 
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3.3 File server  

Status information 

 
 
 
 
 
The File Server is separated from the Signal Server and is installed on a central  PC in the network. Its 
main tasks are: 
 

1. Transfer windows (operator pictures) from master to client. In each client connected to a 
FileSever, you can share an arbitrary window with other stations in the network. The window 
will then function in the same way as in the source client where the window is created. You 
can select a window from the FileServer on-line and it will be active within a few seconds. 

2. Automatical update of changes made in a window to all other connected clients. Any change 
in a window will be discovered by the FileServer and be distributed to all other clients using 
the same window.. 

3. External backup storage of all files. 

 
Note that the File Server must be running if shared windows are to work. However, if the File Server is 
blocked for some reason, you can still run the operator functions from the local station. 
 
Important notice.  When you are finished just minimize the window, do not close it.  
  

List of all connected users of 
file data in the network. 

Sources of file data (Alarms 
and pictures).  
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3.4 Alarm  and event server 

The alarms in a station are always stored locally. The alarm server makes the alarms in other First Op 
clients available in the alarm list where it can be acknowledged and even edited in case that is 
included in the authority.  All alarms and events in the network are stored in a common SQL server. 
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4 How to create a project  

In this section we will describe how you create and configure a project in the FirstOP graphical station. 

 

4.1 Start a new project 

Normal and Edit working modes 
A FirstOp client is configured entirely on-line and each change is immediately visible on the screen. In 
order to make the on-line programming safe, you select between two operation modes: 
  

• Normal mode which means that the station is operated in the normal way. In this mode no 
change can be made in the layout of the operator windows.  
 

• Edit mode  which means that changes are allowed in the station. In this mode, all operator 
commands are blocked for security reasons, i.e. no such commands are sent to surrounding 
systems.  
 

NOTE. If the station is password protected, you must first log in with the correct password before you 
can activate Edit mode, see section 12.4. 
 

In order to change the working mode, select  System → Edit  images  from the main menu and 
mark/unmark ”Edit images”. When the client is set to Edit mode, a yellow indication ”Edit mode” is 
shown in the upper right corner of the window. If you want to leave the edit mode quickly, you can 
simply click in the yellow area.  In this way you can quickly enter Normal Mode, e.g. to make a 
command if needed. The changes you have made so far will be kept.  
 

In order to save the changes you have made, select  Object → Save object. Changes are also saved 
when you exit the FirstOpNet application.   
 

Startup window for an empty project 
When the FirstOpNet software is started from scratch a new ”empty” project is created and the 
following window is shown on the screen:  

 
 
 

Specify  an 
application name 
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The startup window is preset by default as is shown above, and you only need to specify  the project 
name you want to use for your application. When you select  ”OK” the FirstOp client will automatically 
create all the subfolders and files you need for your application which will be stored in a Project 

Folder  which is described below.  At the same time you will get an ”empty ” start-up picture on the 
screen: 
 

  
 
 Be careful to select the application name correctly from start. All local signals, windows and other 
client data is referring to the application name when they are created, i.e. global names are created 
with the application name as a base. The  application name must be unique in a connected network of 
clients. If the application is connected to another or a new network, the same application name may 
be used, i.e. you can copy an existing application and make the modifications you want. 
 
The remaining options in the start-up window are normally not used or will be specified later in the 
project:  
 
Slave station Reserved for future use in special applications  
Dual monitors Multiple screens is normally defined later in the project  
 
  



 Manual FirstOpNet Doc.Id: 1712-1/GB Dat: 2017-12-01 

  

 

 

FirstOpManual-Eng01.docx www.firstcontrol.se Sida: 12 (115) 

4.2 Project Folder 

All subfolders and files that belong to an application are placed direct under the folder where the 
program file is placed as is shown below. In the example below the Project Folder is given the name 
”Project folder”: 
 

 
 
The files in the Project folder define completely the local station and all its connections to surrounding 
systems. Each project folder contains a copy of the program file (.exe) which in the example above is 
given the name ”FirstOp2008 ”. Subfolders and files are created automatically by the FirstOP software 
and are used to store configuration and real-time data. 
 
The most important subfolder is the Data folder which contains all the configuration data for the local 
station. A simple and fast way to make a backup of the project is to copy the Data folder and store it 
under a different name, e.g. Data_BUP.  To restore the backup project you exit the running project 
and replace the Data folder with your backup, note that the name must be changed to ”Data”. When 
you then start the project anew, it will return to the backup version.   
Note. There are other ways to take more complete backups, see chapter 12.3. 
 
Remark 1. If you remove the Data folder from the project file, the FirstOP software will regard the 
project as ”empty” and start up a completely new project where you can define a new project name. 
 

Remark 2.  All data is compressed in the Data folder and therefore also larger applications with 
hundreds of windows and pictures are stored with a relatively small data volume, normally in the area 
20-50Mbyte. 
 
Summing up, the most important subfolders in the Project folder are: 
 
Data All configuration data for the local application 
Timelog Local compressed files of data which is used by the Replay function, see 

separate description.  
Mess Local running messages and information about the local application 
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Statistics Local storage of statistical data to be transferred to a SQL server. The folder is 
emptied when the transfer is made.  

 

4.3 Start and stop the operator station. 

The operator station is started by clicking on the exe-file in the project folder or on a shortcut to the 
exe-file.  FirstOpNet will then read all configuration data from the Data folder and generate all 
operator windows, objects, databases and other configuration data, which may take a few seconds for 
a small application and up to 15-20 sec for a large application with 400-500 windows depending on 
the speed of your computer. The FirstOp client also starts associated programs for communication, 
data logging etc. which are defined. 
 

To exit the operator station you must select System → Exit FirstOpNet  in the main menu on the top 
of the screen and confirm  with ”OK”.  The system will then save all data in files before the program is 
stopped. 
  
NOTE.  For security reasons only one FirstOp application can be started in your PC. Attempts to start 
more applications simultaneously in the same PC are blocked by the client software. If you want to 
start another application you must first exit the one that is running. 
 

4.4 Working with several projects in your PC 

If you want to work with several FirstOp projects in the same computer at the same time, they must 
be placed in different project folders each one with a separate FirstOp file (.exe).   
 

Copying windows from other FirstOp applications in the same network 

If you want to reuse a construction in an existing network you can import windows from the other 
applications and edit them locally as you want. Note that this function should not be mixed up with 
Shared windows described below.  
 
Share windows with other applications in the same network (connected to a File server). 

This function can only be used if the client is connected to a File Server. 
If you want to reuse windows or data constructed in another FirstOp station connected to the same 
file server , you select the window as is described in chapter 5 (select Remote Window) from the 
window library stored in the File server.  This window will then ”belong” to the source application but 
can be used in the same way as in the source.  This function is very convenient if you want to construct 
an ”operator center” based on information within several other local FirstOp operator stations. 
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4.5 Screen settings 

Screen settings that are common for all operator pictures are defined in the menu System 

→ Application settings → Image Display.  The settings are preset by default as is shown below:  
 

 
 
If  ”TitleBar” is selected  then part of the status information at the top of the operator picture will 
disappear. During the construction phase you may temporarily use the ”Title bar” option to be able to 
conveniently  minimize the window. When the station is operative in a process,  it is normally not 
advisable that the operator interface ”disappears” from sight, but it is up to the user to decide. 
 
Important notice. If you change the screen setting you have to restart the operator station to make 
the changes valid.  How you restart the application is described in section 4.3  
 
Description of all settings 
Several screens  If the application is to be run on multiple screens with individual 

display and  handling 
Same images Reserved for special functions (slave)  
TitleBar Windows standard is shown at the top. Is used if you want to be  

able to minimize the window.  It can also be used in operative 
mode, but then some status information at the top will disappear. 

Make room for task bar The Windows activity field is shown at the bottom. Note that the 
total picture area will decrease. 

Maintain aspect ratio  Is used by the FirstOp software to make automatic conversions if 
the screen resolution or picture space is changed, e.g. when PC 
computers are upgraded. 

The Title Bar is used if 
you want to be able 
minimize the window. 
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Font increase/reduce At changes in screen resolutions,  it may be difficult to adapt the 
font sizes properly in an existing design. With this option you can 
manually affect the font sizes at automatic conversion. 

Font increase/decrease 

regulator control  

Manually monitoring the display of command PopUps 

Keep pictures in memory  Normally all operator pictures are stored and updated in RAM 
memory to make the picture changes fast. For very large 
applications with more than 500 operator pictures, the memory 
requirements may exceed the limits set by Windows.  By resetting 
this function,  the application will instead load the picture each 
time it is selected by the operator which may take an extra 0.1-0.3 
sec. 
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5 Working with operator pictures  

5.1 Different types of operator windows.  

There is no absolute upper limit for how many operator pictures that can be constructed except the 
limits set by MS Windows.  The largest applications today contains more than 1000 different operator 
windows, both local and such that are shared with other stations via the File Server. 
 
In order to be able to create or change an operator window you must first set the station in Edit mode 

by selecting System → Edit images  in the menu bar at the top. All user design is made in the running 
system which means that any change will immediately be visible and alive. All operator commands are 
blocked in Edit mode for security reasons,  i.e. no operator command will be processed  until you 

return to Normal mode. You can exit Edit mode by unmarking  the selection System → Edit pictures  
in the main menu or by clicking on the yellow ”Edit mode” square at the top if you urgently need to do 
an operator action.   
 
You work with three different types of operator pictures: 
  

• Base pictures. 

All base pictures are assembled in Picture Groups visible in the  Picture Select table at the 
bottom . The base picture may be opened in three different ways:  (A) By clicking in the 
Picture select table at the bottom, (B) By using the Process menu at the top and 
(C) By pressing the function key shown in the Picture select table 
 
The base pictures have a fixed size and are assembled in at most seven (7)  Picture groups  
which each may contain twelve (12) different Base Pictures, i.e. in total 84 freely configurable 
Base Pictures. If you want to extend the number of operator pictures above this limit, you 
must use the Pop-up windows described  below.  
 

In addition to the freely configurable groups, there are two standard groups Trend and 
Regulator  which are described separately. 

 
• PopUp pictures.  

PopUp pictures are selected via special buttons which can be placed anywhere in a base 
picture or on another PopUp picture. PopUp pictures have a freely designable size and there is 
no absolute limit on how many such pictures you may have. If you open a Popup picture  it will 
be placed in front of the Base Picture you may have open. A PopUp window  can be moved 
around on the screen and will be kept in the front also when you change the Base Picture, i.e. 
they will always be visible as long as they are active.  

 

• Face plates 

A Face plate is a form of a standard PopUp picture which is designed to interface a specific 
type of process object, e.g. an electrical motor, a valve or a regulator. The user designs the 
standard himself using a Popup window to which he connects a group of signals in the signal 
database. He can then reuse the same Popup windows for all objects of the same type by 
simply reference to a group of data belonging to the object.  How a face plate is constructed is  
shown in Chapter 6- 
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There is also an older standard of fixed (non-configurable) face plates  which is kept only for 
compatibility with older installations. Please contact First Control for information. 

 

NOTE. All PopUp pictures and Face plates can be freely moved on the screen by selecting the 
window head and move with the left mouse button pressed. 

 
Important notice!  All design is made on-line meaning that all pictures and animations are active as 
soon as they are created. It is recommended that you take frequent backups when you are working, 
e.g. by copying the Data subfolder in the Project folder or use the built-in backup functions which are 
described in section 10. You can then quickly return to the original version by replacing the current 
Data 
 

5.2 Base pictures and picture groups 

Immediately after a new project has been created, an ”empty” picture will be shown on the screen 
with the following general structure: 
 
 
 

 
 
This is what is referred to as a Base picture below. Such pictures have a fixed structure. 
At the top there are rows for menus, status information and alarm information which are common for 
all pictures. At the bottom there is a Picture select table by which you change the base picture to be 
displayed. The area in between have a fixed size depending on the screen you are using.  This area is 
reserved  for the user to make his design and animations as he desires. When you select another base 
picture it is only this part that is exchanged, the remaining parts remain unchanged. 
 
A number of configurable  status indicators are shown at the top when you enter the Edit mode.  
These indicators can be configured to display the status in surrounding systems. When you return to 
Normal mode,  only the active status indicators which are connected to a signal in the database are 
displayed.  How the status indicators are configured  is described  in section 8.28. 
  

Standard menus 
Status info 
Alarm info 

Picture select table 

Design area to be configured by user 

Configurable for status display of surrounding system.  



 Manual FirstOpNet Doc.Id: 1712-1/GB Dat: 2017-12-01 

  

 

 

FirstOpManual-Eng01.docx www.firstcontrol.se Sida: 18 (115) 

 

Creating base pictures and picture groups  
In order to create or change an operator pictures you must first set the client in Edit mode. 

Select Show → Project window from the menu row to display the whole picture structure: 
 

 
 
To set the group  properties, click with the right mouse button on the symbol”Group1” and choose  
Properties from the submenu to display the properties of the window:  
 

 
 
Define the TagName and a short description in Text as is shown above.  
 
The properties of  ”Window1” are defined in a similar way. Click with the right mouse button on the 
symbol  ”Window1” and select Properties in the submenu to display the properties for the Base 
Picture: 
 

 
 
Then specify an appropriate TagName and add a short description Description as is shown above. 
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Next select a suitable back color and fixed background picture by marking the properties BackColor  

and Picture  and click on the small buttons at the side for selection:  
 

 
 

 
 
You have now created a base picture  as is shown below which can be supplied with you own 
animations and displays as is described in more detail later: 
 

 
 
 
The picture select table at the bottom of the screen is now updated with the new names you have 
defined 
 

 
 
Observe that the base pictures within a group are placed on the upper row and the picture groups on 
the lower row.  To activate a base picture you can now either click in the picture select table with the 

Select a background 
color 

Select a suitable picture 
in your browser 
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mouse pointer,  press the displayed key on the keyboard (F1 and Q in this case) or look up the picture 
in the Process menu at the top. The picture select table is automatically upgraded when you add more 
pictures to your station. If you have many pictures you should use short descriptions so that they fit 
within the limited area of the picture select table. 
 
Remark. After each change you must make a picture change  to have the picture select table updated. 
 
The project tree will now look like: 

 
 
The project tree will expand as you add new Picture groups and Base pictures. It is therefore  
important that you already in the beginning specify TagName and Text so that you easily can identify a 
specific picture in the tree. 
 

Adding groups and pictures 
We will now  continue with the example above and add a new base picture in the picture group 
”First_group” in the project tree.  By clicking with the right mouse button on the group symbol you will 
have a number of options: 

 
 
 
You have the following options: 
 

• New Window. A completely new ”empty” window is created. 
• Paste Window.  You can copy another window in the project tree by marking it with the right 

mouse button and select ”Copy Window” in the submenu and paste it as a new base picture, 
which you may use as a template to be edited.  

• Import Window. 
You can also make a file import from another station. In this case you create a completely new 
window which then must be connected to signals in the local database.  

• Add Remote Window (only if you are connected to a File Server).  
You may select a window already constructed in another station in the network. The remote 
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window will then keep all its original settings including all real-time data it is using. The 
window still ”belongs” to the source station, i.e. it is executed in the source but can be 
operated from remote. In case a change is made in such a window, there will be an automatic 
updating in all other stations in the network using the same window. 

 
You must make a clear distinction between ”Add remote window” where you share the window with 
several other stations in a network and ”Import Window”  where you create a completely new local 
picture in the station. 
 
You choose New Window in the menu above if you want to create a new empty window. The project 
tree will then be extended with a new ”empty” window. The new window is named as is described 
below, and in this example we have named it ”Second window”. We have also added a new group 
”Second group”: 
 
 

 
 
 
The picture select table will also expand automatically when you when you add a new base picture 
and a new group: 

 
 

Reordering  the picture table 
Operator pictures and picture groups will be displayed in the same order as in the project tree. If you 
want to change the display order of  the buttons, you simply select the symbol in the tree with left 
mouse button pressed and move it upwards or downwards whatever you prefer. 
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5.3 PopUp windows 

A PopUp window is an operator picture that functions in the same way as a base picture, but  has a  
configurable size and is activated from a special picture button in a base picture or on another PopUp 
window. There is no theoretical limit on the number of PopUp windows  in an application,  except the 
practical limit set by the Windows version used. 
 

Creating a PopUp window 

In order to create a PopUp  you must be in Edit mode.  Select  Show→ Project window  in the menu 
row at the top and click with the right mouse button on the PopUp symbol:  
 

 
 
What the different options means is describe above for Base pictures and is also valid for PopUp 
pictures. If you select New Window a new window is created automatically with a standard 
name(Window4): 
 

 
 
Click on the window symbol  (Window4) with the right mouse button  to open the property window. 
In this example we have chosen TagName = ”PMP_STN” and Description =”Pumpstation”: 
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We are using the same properties as was done for base pictures (see above)  but in this case you can 
also define the window size by the properties  Height/Width expressed in pixel. 
 
Double-Click on the PopUp symbol (”Pumpstation” in this example) in the project tree to open the 
PopUp picture for design, see below. The picture area can be used for design and animation in the 
same way as a base picture, i.e. you can build a complex picture describing a complete process or 
simple Face plates for process objects. 
 

 
 

Prioritizing and Moving PopUp windows  
 
The size of a PopUp window can be moved freely on the screen by selecting the head with the left 
mouse button pressed. 
 
There is a special prioritizing of PopUp windows on the screen that prevent ”hidden” windows. A 
PopUp window is always placed in the front of the base windows.  Moreover a PopUp window does 
not disappear if you change the base window, i.e. they are always placed at the front in the same 
position on the screen.  This means that the operator can open the PopUp windows he is  currently 
working with at the same time as he can supervise  the process and change the base windows without 
affecting the PopUp windows he is using for his task. 
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The operator can always use the ClosePopUp button in the top right corner  to close all PopUp 
pictures currently active on the screen if it becomes too ”messy” and reopen the PopUp windows he 
wants to work with.  
 
It may for instance be convenient to use PopUp windows for object handling and sequences  which 
then are available even if the base windows are changed.  
 
If multiple screens are chosen in the  Screen settings in section 3.6 you can freely select the windows 
on the different screens individually.    
 

Open and close  PopUp windows  
 
In Edit mode a PopUp window is opened by double clicking on the symbol in the project window. 
  
In Normal mode special PopUp buttons are placed on base picture or on an another PopUp picture.  
To create a PopUp button, select  Edit → New object → PopUpButton  in the main menu.  A button is 
then immediately created and placed on the screen.  You move the button to the position you want by 
keeping the left mouse button pressed. You can also change the size by dragging the handles visible on 
the object, see below 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
For the remaining settings make a click with the right mouse button on the object and all properties 
are displayed. In the property window you can select colors, text and font to be used on the button. 
You also select the PopUp window to be displayed by marking  in ”PopupWindow” property, click in 
the small square and select from the list of available PopUp windows. 
 
You close the PopUp window by clicking on the red x in the upper right corner. 
 

Remark . The PopUp button does not work until you have left Edit mode and returned to Normal 
mode.  
 
A click on the button in Normal mode will open the PopUp window. You close it by either clicking in 
the square x in the upper right corner or click on the button ClosePopUps 
 
A convenient way of working is to copy the button and place it on all pictures where you want to be 
able to open the PopUp picture.  Note that you have to be in Edit mode do this procedure. 
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Using Shortcuts  
If you want to open several PopUp windows with one selection you can use the menu function 
Shortcut control which is tool for the operator and therefore is defined in Nomal mode. A Shortcut  
can for instance be used to open all PopUp windows that are used to control a complete process part 
or special start-up sequence. The Shortcut function is described in detail in section 9.6 

5.4 Copying windows  

A simple way of creating new windows with similar data is to copy and paste. 
 

1. Open the project tree in Edit mode and click with the right mouse button the window you 
want to copy. Then select  Copy Window  in the submenu. 

2. Then click with the right mouse button on the Picture group where you where you want to 
place the window and select Paste Window  in the submenu. All animations in the form of 
command objects and display objects will be unchanged and can be edited in the normal way.  

 
In the example below we have copied the PopUp picture ”Pumpstation(PMP_STN)” and created a 
copy ”Pumpstation(PMP_STN_Copy1)”.  By opening the property window of the PopUp you can then 
set the TagName and Description as you want. 
  

 
 
In order to make the editing work simpler, there is a special editing function in the main menu of the   

PopUp window. By using  Edit→Replace references  you can make a text editing of all the signal 
references  in the window.  
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5.5 Removing picture groups and windows 

You remove a Picture Group including all windows within the group by clicking with the right mouse 
button on the group symbol in the Project tree and select Delete Group in the submenu. You must 
confirm the action by clicking  ”OK”. 
 

 
 
As soon as the action is confirmed, the Picture Group with all its windows will disappear from the 
system. 
 
If you want to remove a picture you do in a similar way.  Click with the right mouse button on the 
picture symbol in the project tree and select Delete Window in the submenu. 
The action must be confirmed before the picture is removed from the system.  
 

 
 
The picture will disappear as soon as the action is confirmed.  
 

Warning. A picture group or a picture that has been removed cannot easily be recreated. Therefore it 
is important that you to take frequent backups of the station when you are working with it.  
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5.6 Adding your logotype 

 

 
 
On the top row on the screen you can add your own logotype in the following way:   
 

1. Set the station in Edit mode. 
2. Create a logotype picture in format ”emf ”, ”jpg”, ”bmp” or ”gif” with relative dimension 

1650/360 to avoid that the picture is distorted when inserted.  
3. Click on the Logotype area and select your picture in the browser  that will appear. 
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5.7 Picture layers with added information 

Each Base picture may contain up to three different picture layers with added information.  The 
current layer is shown in the picture head. The basic information is placed on the lowest level (0). The 
remaining layers shows information added two the basic layer in two steps. All picture objects 
available can be placed on any of the layers as is specified in the property window. 
 
The Operator changes the added layers pressing”Page up” and ”Page down” on the keyboard. In the 
example below the second layer is used to display formal text identies for the process objects (as a 
complement to using the mouse pointer). 

 
. 
 
REMARK. The information placed on layers 1,2,3 are each individually  placed ”on top” of the 
information in basic layer 0 to display different types of added information. Hence the information in 
level 0 is always visible.  

Picture layer  0 Picture layer 0+1 

Page Up  
 
Page Down 
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6 Dynamic symbols (Face plates) 

Dynamic symbols or ”Face plates” are PopUp windows with a standard layout which can be reused for 
all process objects of the same type, such as e.g. motors, valves, regulators.  
 
A face plate consists of the following 
 

1. Internal database  where all data that is used in the symbol is defined. 
2. PopUp windows which are included in the symbol 
3. Symbol images which defines the status of the symbol. 

 
All dynamical symbols are assembled in a library file which can be manually copied to be used in other 
stations.  
 
Scada network: 

If the station is connected to a scada network,  the library file is stored in the File Server and can be 

used by all FirstOp clients connected to the same File server. 

6.1 Creating a symbol library 

 

Open the symbol library by selecting System → Application settings → Dynamic symbol designer 
 in the menu at the top.  At startup there will be an empty library: 

 
 
Then select ”New symbol” from the File menu to create a new dynamic symbol: 

  
 
In this menu you may create a new symbol, edit or delete an old symbol.  
Select ”New symbol” to open the design window. 
 
  



 Manual FirstOpNet Doc.Id: 1712-1/GB Dat: 2017-12-01 

  

 

 

FirstOpManual-Eng01.docx www.firstcontrol.se Sida: 30 (115) 

 
Design window (Symbol editor) 

 
The design window is used to specify all properties for the symbol. It consists of four tabs: 
 

1. General 
2. Tags 
3. Window designer 
4. Symbol images 

 
Select ”File->Save” to save the symbol in the library. 
  

Tab General 

 
 
The ”General” tab is shown when you open the symbol editor. Fill in the name and a short description 
of the symbol, in this case we will construct a regulator face plate. 
 
General properties for the symbol: 
 

• Symbol name Specify a unique name for the symbol. 
• Symbol description  Specify a short description for the symbol 
• Alarm signal Select a signal from the internal database after the tags are defined. If the alarm 

signal is true then there will be red frame visible around the object as is shown below. 
 

 
 
In this case we are going to construct a simple regulator face plate with name ”REG”. 
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Tab Tags 

 

 
 
Here you define the internal database for the symbol. Click with right mouse button anywhere in the 
window area to open the edit menu. Select one of the options  ”New tag”, ”Edit tag” or ”Delete tag” . 
If you chose ”New tag”  or ”Edit tag” an input window is displayed where you can fill in your data. If 
you select ”Delete Tag”, the tag will disappear after conformation. 
 
Remark. Use short names for the tags since they will be a part of a longer tagname later. In the 
description you can clearly explain whatever is needed.  
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Tab Window designer 

 

 
 
In the window designer you define all the popup windows that will be included in the symbol. Click 
anywhere in the window area to get the edit menu ” New window”, ”Edit window” and ”Delete 
window”.  If you add a new window you must specify its name and description. You will then get an 
”empty window” on the screen which you design in exactly the same way as normal popup windows. 
The only difference is that some picture objects are not available. The available picture objects are 
displayed by clicking anywhere in the picture area and select ”New objects”. 
 
When connecting the picture object to signals, the browser will only show the internal tags defined for 
the symbol as is shown below: 
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Tab symbol images 

 

 
 

The tab ”Symbol images” is used to define symbol pictures which are shown on the screen displaying 
the status of the symbol. To each image you can connect a signal from the internal database. In this 
case two symbols are defined,  one if the regulator is in  ”automatic mode” and one for ”manual 
mode”. The symbols are show in priority order starting from picture no ”1”, i.e. if both logical signals 
”AUTO” and ”MAN” are true picture no 1 is shown. In case no signal is true, picture no 1 will be 
displayed. 
 
The image formats supported are ”.bmp, .jpg, .gif”. Vectorized format accepted is ”.emf” 
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6.2 How to use dynamic symbols 

 
Set the station in Edit mode and select Edit ->New object->Dynamical symbol. The local symbol library 
is then opened: 
 

 
 
Click on the symbol you want to use and the symbol will appear on the screen: 
 
 

 
 
 
 
 
 
 
 
The symbol is connected to a folder in the database with the same data structure as the symbol. Each 
signal is identified by the last part of the name  (.xxx)  which should coincide with a tag name in the 
symbol.  
 
If you now return to normal mode and click on the symbol to open the face plate: 
 

Select a regulator folder 
in the database 

Select a popup window 
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The regulator face plate is now running and you can operate it directly. The folder you chose is in fact 
an identifier shown in the head of the specific regulator you have chosen to operate. 
 
As any other popup picture, the face plate can be moved anywhere in the screen area. It is placed in 
the front so it will not disappear when the base pictures are changed. A common way of working is to 
open the face plates you want to work with for the moment and place them in a suitable place in the 
screen area so they are available even if there are other matters to take care of. 
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6.3 Import of external windows 

 
If you already have constructed  some popup windows it may be convenient to reuse them as face 
plates by importing the window and reuse the window design and the data connected to it. We will 
illustrate with an example. In this installation there are about 50 motor drives  of the same type. The 
designer has created a PopUp window for the operator shown in the figure: 
 

 
 
To create a face plate based on the popup window you must first create a new symbol in the Dynamic 
symbol designer (select ”System->Application settings-> Dynamic symbol designer”): 
 

 
 
We name the new symbol ”MOTOR”. 
 
Next open the window designer  and click anywhere in the area with the right mouse button to open 
the editing menu: 
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Select ” Converting existing window” and look up the window you want to import in the browser: 
 

 
 
In this case we select the window named ”EEB22 AF 061” which is an identification standard used by 
this customer. The window designer will display the new popup: 
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The popup name  ”Window_1” and description ”EEB22 AF061” can be edited by opening the property 
window of the popup as is illustrated below . The window designer has now imported all design in the 
original window except those which are not allowed (e.g. DynGraph). 
 

 
 
If you open the ”Tags” tab you will see that all names used in the imported popup window is included 
in the internal tags for the symbol: 
 

 
 
 
 
 
 
 

Click with the right mouse 
button anywhere in the popup 
area or use the ”Edit”  menu to 
open the property window. 
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Using the imported symbol 
 
Select  ”Edit ->New object->Dynamic symbol” in Edit mode. You will then get the symbol library 
displayed. 
 

 
 
Click on the symbol you want to use to place it on the picture page and open its property window: 

 
 
 
 
 
Here you connect the symbol to the folder holding the data  ”EEB22 AF016” using the browser. Also  
select one of the popup windows ” MOTOR-OP” which you select using the browser. 
 
Now the design is complete.  If you click on the symbol, the face plate for the selected motor will be 
opened: 
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7 Signal database 

7.1 Open the signal database 

Signal database contains all real-time process data the local operator station uses.  It also contains all 
configuration menus for data properties and connections to the control system. You open the signal 

database by selecting System → Signal database  from the menu at the top. The client will then open 
a new window where the database is displayed as an information tree. If we open an ”empty” 
database it will look like: 
 

 
 
The FirstOp client creates automatically four main groups automatically: 
 

• Signals. All signals (data) used by the station including local signals, signals communicated 
from external systems and operator commands. 

• Signal Groups. Grouped signals taken from  Signals which are used for standard fixed objects 
in the client (older standard) 

• Alarms. All alarm signals used by the system. 
• Sources. Protocols servers communicating data with external systems. 

 
If we expand the tree by marking ”+”  in the empty database, the following symbols are displayed:  
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Each main group is divided into two parts:  
 

• A Local part  (FirstOp_Projekt ) where  ”FirstOP_Projekt” is the local Application name defined 
at the project start. All data stored in this part is generated  in the local client and is said to 
”belong” to the client in a network.  

• A global part (Net) (only if connected to a Signal/File server) which contains all data in an 
Operator windows belonging to another client via a File/Signal server.  If no server is installed 
this part will be empty. 

 
Two standard folders are automatically generated in the local part: 
 

• $System  which contains system data from the local station. The system data can be made 
visible in operator pictures. 

• $Statistics which contains local statistical signal data which by a special marking can be made 
visible in the local signal database. Besides being transferred to global SQL servers, this data 
can also be made visible in operator pictures. 

• Sources contains protocol servers planned for future use.  ”MCProt” handles the 
communication with First control’s control system MicroController XC. 

 

7.2 Creating a signal database 

All signal data including process data and operator commands are stored in the folder $Signals in the 
information tree. Data can be stored under groups in subfolders on several levels.  
In order to create a new data folder named ”MXC01”,  click with the right mouse button on the 
symbol and select New Group: 
 

 
 
 
You then get an input window on the screen where you specify the name, ”MXC01” in this example. 
You have now created a new  group”MXC01” which is placed directly below  ”FirstOp_projekt”: 
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In this example we will create three subgroups ” AI”, ”DI” and ”REG” in the MXC01 folder. Repeat the 
procedure above and click with the right mouse button on the symbol ”MXC01” and  select New 

Group to create the subgroups and their names. You have now expanded the information tree with 
three new groups:  
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7.3 Signal definition window 

The signal database is best created by importing the signal definitions using an MS Excel sheet. How 
this is done will be described later. 
 
We will first describe how you create signals directly in the database. If you need to edit the 
definitions later, this is normally the most convenient way to go. Click with the right mouse button on 
the folder where you want to place the signal and select New Item from the popup menu that will be 
shown. A Signal definition window is then displayed: 
 
 

  
 
If the signal already exists in the database you can instead double-click on the signal to open the 
definition window which then already contains some signal specifications. Signal definitions can be 
changed freely during running and the specifications will be valid directly after the definition window 
is closed.   
 
Important notice! All the dynamical connections to a signal in the operator pictures are kept even if 
the TagName is changed. 
 

The definition window contains five different Tabs each describing a certain type of data for the 
signal: 

• General data (Tab ”General”). Here the TagName and other general properties of the signal 
are defined. 

• Signal scaling (Tab ”Scaling/Decimals”). Scaling settings for Real or Integer type of signals are 
defined. NOTE.  The tag disappears if you have selected ”logical signal” in general data since 
logical signals do not have a scaling.  

• Alarms (Tab ”Alarms”). The alarm properties of the signal are defined. 
• SPC statistics (Tab ”SPC Logging”). You specify how to generate statistical data to be stored in 

an SQL server and/or displayed in the local database. 
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• Events (Tab ”Events”). You define special conditions for generating system events.  

We show below how the different tabs are to be filled in one by one. 
 

7.4 Tab General data 

 
In the tab General basic properties of the signal are defined, see the example below.  
De different properties are: 
 

Data  Description 

Name 

(TagName) 

The signal name (TagName) must be unique within the group and must consist of 
a coherent string of characters not containing dot(.) or space character. Special 
characters (like Å, Ä and Ö in Sweden) is accepted but should be avoided since 
they may create a problem if transferred to other systems.  

Description Short description of the signal. Also special characters are accepted. 
Data type Selection is made from  a list containing:  

• Bool = signal with a logical value 
• Real =  signal with a real value 
• Int = signal with an integer value 
• Text = text string 
• Date/Time= date and Time 

ClientAccess Selection from a list containing: 
• Read = data recieved from the control system 
• Write = data sent to the control system 
• Read/Write = data from  and to the control system (both)  
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TagType Selection from a list containing: 
• External= signal from/to the control system 
• Local = signal only used locally in the station( e.g. computed value in a 

Script) 
Global Selection from a list containing: 

• Full Access =  the process signal and/or command is available for all 
clients connected to the same signal server.  Operator commands can be 
issued anywhere in the network.  

• Limited Access = only the process signal is available to other clients 
connected to the same signal server. Operator commands are blocked 
on the network and can only be done in the local station.  

• None=No process signal or operator command can be used by other 
clients. They are only available locally.  

Decimals Number of decimals to be displayed in picture objects on the screen and in the 
signal database.  

Units Engineering unit to be displayed with signal value. 
Source Protocol server for control system (PLC) . MCProt in this case means  First 

Control’s own system MicroController XC.   
Address read The property is shown only if  ”Read” or ”Read/Write” is selected in the 

ClientAccess property and specifies the address in the control system containing 
the data, see description below. 

Address write The property is shown only if  ”Write” or ”Read/Write” is selected in the 
ClientAccess property and specifying the address in the control system where 
the signal value is to be stored. The syntax for a write address in a 
MicroController XC control systems is described below.  

 
Reading data in MicroController XC (Address Read) 

Data is sent from a MicroController XC  to  an operator station in the form of SignalPacs which are 
grouped signals which may be of type Real(R), Integer(I) or Logics(L). Each Pac may contain up to 255 
signals of each type.  The syntax of the reading address is: 
 
PacName. Signaltype.PacNr.SignalNr 

 
PacName The name of the Signal Pac sent from the control system, max 8 characters 
Signaltype R=Real, I=Integer, L=logical signal  
PacNr Pac number in a Signal List (=1,2,3…) or for a SignalPac (=0). 
SignalNr Signal number in the Pac (=1,2,3...) 

 
Where each part is separated by a dot (.). The signals in the database are updated as soon as a new 
Pac is sent to FirstOp with a maximum delay of about 10 ms depending on the capacity in the PC.  
 
In the example above the read address is ”PIC510.R.1.5”, which means that the signal value sent from 
the control system belongs to Signal List ”PIC510” , pac nr ”1”  and is Real signal nr ”5” 
For more information about the database structure in the control system, see MicroController XC 
manual. 
 
Writing data to a MicroController XC  (Address Write) 
Sending data from the FirstOp station to a MicroController XC can be done in two alternative ways 

• Direct method.  The data message  is sent to a specific address in the XC database. 

• Indirect method. The data message must be decoded locally in the control system.  
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The Direct method. 
A direct data message contains information about where the data is to be stored in the database for 
the control system. The syntax is 

Unitnr.Memory.PacName. Signaltype.PacNr.SignalNr 

 

where 

 
Unitnr The identity of the MicroController XC  to which the data is sent. The 

identity is the last number in the IP-address, i.e. xx.xx.xx.unitnr 
Memory The local memory (L,B,G)  where the data is to be stored.  

L=  Local memory 
B= Backup memory where data is preserved on flash 
G=Global memory where data can be transferred to other XC units. 

PacName The name of the Signal Pac sent from the control system, max 8 characters 
Signaltype R=Real, I=Integer, L=logical signal  
PacNr Pac number in a Signal List (=1,2,3…) or for a single SignalPac (=0). 
SignalNr Signal number in the Pac (=1,2,3...) 

 

Example: 

 

In this example we have defined the signal ”MCV” to be ”Read/Write”. The data is sent to unit nr ”1 ”, 
to be stored in ”B”memory in a Signal List by name ”DATA”, as real signal (”R”) in pac nr ”1”, real signal 
nr ”2”. Since the signal is defined as read/write the value may be sent back to the operator station for 
display, which is a common way to handle operator settings with value confirmation. 
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Indirect message  

The indirect data message consists of two different  pacs of data  depending on the type of data sent: 

• ORDERL for a logical value  
• ORDERF for a real or integer value  

Where ORDERL and ORDERF are two pacs that must be created in the global memory in the control 
system. They contains the data value and a number of integers which are used by the control systems 
to identity the data, The syntax is as follows: 
 

• UnitNr.PacName.int1.int2.int3.int4.int5 

 
Where  
 

Data Description 
UnitNr MicroController unit nr, i.e. the last number in the IP address 
PacName ORDERL for logical data or ORDERF for real or integer values  
Int1…Int5 Integers which are decoded internally in PLC system 

 
The integer codes can be interpreted by the control system as the user wishes. One example of how it 
can be used is shown below 
 
Example:  

 
 
Comment. 
It is very important that all operator commands that go via a network are secured  so they are directed 
to the correct object.  The signal server receives the command and directs it to the right source. The 
communication is binary coded so in practice it is almost impossible for external sources to intervene.  
By the property ”Global” shown above, it is also possible to block operator commands that requires 
local presence, e.g. resetting a security system or a start-up sequence of a sensitive process part.  
. 
  

Logical value sent to MicroController 
nr ”4” to be stored in a signal list 
”OBJ_IN”, object nr ”160”, logical 
signal nr ”2”. 

Analog value sent to MicroController 
nr ”4”, to be stored in a signal list 
”OBJ_IN” , object nr ”116”, real signal 
nr ”4”. 
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7.5 Tab Signal Scaling/Decimals  

 
 
The scaling to be done depends on the selection of  ClientAccess , i.e. if the signal is defined as”READ”, 
”WRITE ”or ”READ/WRITE” . The scaling is made separately for sending and receiving data. 
 
Scaling of receiving data (READ) 

The data has been sent either as a real signal or an integer signal to the operator station. The user can 
select another scaling and chose which data type to be used internally. 
  

Data READ Description 
Scaling • None no scaling 

• Linear scaling is made  
Raw Value Range The signal range at the source (the control system): 

• High= raw signal upper limit 
• Low =raw signal lower limit  

Scaled value range The signal range in operator station : 
• High = scaled signal upper limit 
• Low = scaled signal lower limit 

Data Type Data type is selected from a list: 
• REAL =  scaled signal is treated as a real value  
• INT = scaled signal is treated as an integer signal  

 
Remark: The scaling means that the upper/lower limit of the incoming signal is scaled to correspond 
to the upper/lower limit of the scaled signal (easier to specify than gain/offset). 
  

Note. The tag 
”Scaling/Decimals” is 
visible only for signals 
defined as ”Real” or ”Int” . 
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Scaling of sending data (WRITE) 

Data to be sent to the control system is scaled separately. 
 

Data WRITE Description 
Scaling • None no scaling 

• Linear scaling is made  
Raw Value Range The signal range in the operator station: 

• High= raw signal upper limit 
• Low =raw signal lower limit  

Scaled value range The signal range in the target (control system) : 
• High = scaled signal upper limit 
• Low = scaled signal lower limit 

Write incr The increment used in command windows  for value setting. 
”Increase” and ”Decrease” functions are using the setting. 

 
Remark 1: The scaling means that the upper/lower limit of the raw signal is scaled to correspond to 
the upper/lower limit of the scaled signal (easier to specify than gain/offset). 
 
Remark 2: The signal value sent to the control system will always be real valued, where it can be 
converted to integer if necessary. 
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7.6 Tab Alarm 

Analog alarms 
The definition window is adapted to the signal type that is selected. If the signal is Real valued (REAL) 
or Integer valued (INT) the appearance is:  
 

 
 

Description of settings:  
 

Data  Description 
Activate alarm level  Select which of the levels  (Very High, High, Low, Very Low) by 

marking to the left and the settings are displayed to the right.  
Text The alarm text is filled in automatically based on the description 

of the signal, but can be changed if the user wants.  

Limit Specify the alarm level for the signal 
Prior Select priority level from the list (A,B,C,D etc.) 
Hyst Specify a value for the hysteresis to avoid multiple alarms close 

to the limit, else set =0 
Delay Time in sec  before the alarm is activated after a limit has been 

exceeded. 
Interlock Any signal in the database can be used to block the alarm to be 

activated. Select the blocking signal with the browser.  
Inv If the blocking signal is to be inverted. 

 
The alarm is active as soon you have marked ”OK” and closed the database window. 
All activated analog alarms are displayed in the database under the folder Alarms in the information 
tree. 
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Note that the folder Alarms is structured in the same way as Signals where the signal producing the 
alarm is placed to make it simple to identify which alarm signals are defined in each group.  
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Digital alarms 
If the signal is a logical signal (BOOL) the tab will look like:  
 

 
 

Description of settings:  
 

Data  Description 
Text When the alarm is activated, the alarm text is filled in 

automatically, but can be changed if the user wants. 

Invert The alarm is activated by the inversion (NOT) of the signal 
Prior Select the priority level (A,B,C,D etc.) 
Delay The alarm is activated after it has been active for more than 

”Delay” seconds. 
Interlock The alarm may be blocked by any logical signal in the database. 

Look up the signal using the browser to the right. 
Inv The alarm is blocked by the inverted (NOT) value of the blocking 

signal 
The alarm is active as soon you have marked ”OK” and closed the database window. 
All activated digital alarms are displayed in the database under the folder Alarms in the information 
tree: 
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7.7 Tab SPC statistics 

The definition window is used to define the statistical logging of signals to be stored in a SQL server  
and/or to display the statistical values on the operator screen. The setting parameters are the same 
irrespective of data type.  The statistical calculations performed are described below.    
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Description of settings: 
 

Data  Description 
Logging Click in the box  to activate the statistics for the signal and the 

remaining settings will then appear. 
Interval The cyclic time interval during which statistical calculations are 

made. Select the time unit  Seconds, Minutes, Hours or Days and 
select Time from the list. 

Include in signals If this option is selected, the calculated statistical values will be 
displayed in the folder $Statistics. The data can then be used for 
display in the operator pictures. 

Log to report 

database 

If this option is selected, the calculated values will be stored in local 
files which are transferred to an SQL server as soon as it is 
accessible.  

Don’t log to database The local storage in files is blocked.. 
Calculate floating MV Calculate and store floating mean values during the logging interval. 
DB par Name A unique parameter name in the SQL is generated automatically. If 

you want to change the name,  select ”Change” and specify the 
name you want.  Note that the name gets an addendum that 
specifies which type of calculation is made, see the example from 

$Statistics below. 
Reset ACC Accumulated values are calculated for digital signals which can be 

resetted by clicking on the button. 
Check valid Is used to set validity conditions on the signal. Select a suitable 

logical signal in the database using the browser and specify the 
portion of the time interval (0-100%) the signal must be valid to 
allow sending to the SQL database.  
Comment: This option was added to satisfy formalities in reporting 
energy production data defined by authorities. 

 
Computing statistical data SPC. 

Statistical data (SPC) can be calculated for all signals in the signal database and be stored in an SQL 
server for production reporting and post analysis. The statistical values can also be displayed in the 
local signal database which can be displayed in operator pictures.  SPC calculations can be made for 
analog signals (data types Real, Int) and for logical signals (data type Bool).  The statistical calculations 
start as soon as the SPC function is activated in the signal database. 
 
For each time period (”Time” in the definition window) the following is calculated:  
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Logical statistical values stored 
 

TON The time the value  =1(true) during the period 

TOFF The time the value  =0(false) during the period  
NON Number of changes 0/1 during the period 
NOFF Number of changes 1/0 during the period 
TONACC The time the value  =1(true) accumulated for all periods 
TOFFACC The time the value  =1(true) accumulated for all periods 

 
 
Analog statistical values computed 
 

MAX The maximal value during the period 

MIN The minimal value during the period 
MV The mean value during the period 
STDAV The standard deviation during the period 

 
The signals are read at high speed and therefore all variations in the signals are catched in the 
statistical SPC measures which give a very high quality in the historical data. For instance, the logical 
statistics will display how many times you have switched a process object on/off and for how long 
time the process object has been running/not running.  
  

Calculation period (”Time” in definition window) 

1  1/0  0  0/1 

Max  Mv  Min 

Logical values used 
by SPC statistics 

Analog values used  
by SPC statistics 
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7.8 Tab events 

 

 
 
If you activate ”Record Event Write” all operator commands using the signal will be registered in an 
event list which can be displayed together with the alarms to analyze a sequence of events, see 
examples in section 10.4. 
 
Warning. The picture object Joystick will generate rapid cyclic send messages and therefore this 
property should not be activated for signals used by the Joystick object since the event list will be filled 
up. The function should be activated only for write messages which are not repeated automatically 
such as e.g. operator commands.  
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7.9 Signal import/export. 

General 
The signal database can be created and edited directly as is explained above. A more convenient way 
is to use export and import of MS Excel files which are saved in format ”.csv” or (tab limited) ”.txt”. 
Database import/export is made from a menu in the database window:  
 

 
 
 

• Export produces an export file of  the whole or a part of the signal database or a part in the ”.csv” 
format which can be opened in MS Excel.  The export file will then be a complete documentation of 
the database in a readable format. The file can then be edited and reimported as a whole or in parts.  

• Import must be done from a MS Excel file saved in the ”.csv” or (tab limited) ”.txt” format. The file 
must have a fixed structure which is the same as is shown in the export file. The simplest way to work 
is to first make an export file to get the structure and add new signals and/or make the changes in 
existing data.  Remove all rows except those that are to be changed. Then  you may import the edited 
file. 
 
REMARK.  The exported version will be a ”.csv”.  Change it to ”.txt” to be able to use it with all later 
MS Excel versions. 
 
 
OBS. It is recommended that you take a copy of the Data folder before you make an import since a 
mistake may have big consequences. If a problem arises, close the operator station, put the original 
Data folder  back and restart the operator station. Note that all work is done on-line in a running 
operator station  
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Export of signal data 

To export an existing database, select Export →Tags→All  if you want to export all the signals in the 

database or Export →Tags→Group if you want to export a certain group in the database. In the 
example below we have exported the whole database to illustrate the principles:  

 
 
The properties are displayed column wise and each row corresponds to the data which are defined in 
the Signal definition window. By expanding the window to the right, you will see all the properties 
which are defined. 
 
The local tagname is written with dots (.) separating the different levels in the database tree.  The 
signal ”MXC01.REG.BV_REG” is thus placed in the group ”MXC01.REG”: 
 

 
 
The global TagName   in a network is the local  TagName preceded by the ApplicationName separated 
by a dot (.). Since the ApplicationName in this example is ”FirstOp_Projekt”, the global TagName in 
this example will be”FirstOP_Projekt.MXC01.REG.BV_REG” 
 
Remark. If you make a complete export of all signal data, you will also get a complete backup of the 
database which may be reimported later. 
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Importing signal data 

In order to import signal data from an Excel file, select  Import →Tags in the File menu and look up 
the files you want to import by the browser. The file should be saved  as (tab limited) .txt format 
which is done inside the Excel application. 
 
The simplest way to create an import file is to use an export file and edit it. To illustrate the procedure 
we import signal data for analog input channels by reusing the first signal in the export file shown 
above. We create an import file using the first item ”MXC01.AI.AI_CH1”  in the exportfile and remove 
the rest.  Edit the data and save it as (tab limited) ”.txt”: 
 

 
 
The signal database will be updated after the import as: 
 

 
 
 
REMARK.  The new tagnames are added to the existing names. Existing names are not affected, unless 
they are included in the import file. If an imported tagname is already present within the group, then 
the signal will be replaced by the imported data.  
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7.10 Sorting and restructuring database  

Sorting values 
The contents in the database may sometimes be very large. To make it easier to find a special data, 
you can sort the data in alphabetical order by clicking on the column in the head. 
 
In the example below we have clicked ”Tag Name” to get the data sorted in alphabetical order by the 
tagname. It is common to sort by ”Data Type” to display all the signals of a certain type or ”Address” in 
order to display the signal update from a specific signal pac sent by the control system.  
 
Remark. The same sorting rules are used when you look up a signal in a browser to make a signal 
connection to a dynamical object. 
  

 
 

Restructuring the database  
Signals can be moved in the database tree if you want to change the tree structure. One example: 

 
You can move the data in the database tree in a simple way using the procedure shown above, i.e. 
 

1. Mark the signals to be moved by the left mouse button. 
2. Click on the surface with the right mouse button to display the menu and select ”Cut”.  

Mark the signals to be 
moved by the left mouse 
pointer.  Click in the 
marked area with  the 
right mouse button and 
select ”cut”. Repeat the 
procedure in the target 
group and select ”paste”   
to move the data. 
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3. Enter a target folder in the database tree where you want the data be placed.  
4. Click again in the target folder with the right mouse button and select ”Paste”.  

 
All connections in the picture objects are changed accordingly.  
 
Important notice. All database connections which are made in picture objects are changed to the new 
database position if you do ”Cut”+”Paste”.  If you do ”Copy”+”Paste”instead, then the database 
connections will be unchanged since the original signals remains.  It is not possible to first do 
”Copy”+”Paste” and then  ”Delete” on the old signals if you want the database connections to be 
adapted automatically.  
 

7.11 Display of statistical and system data. 

Display of statistical data 
If you activate  Include in signals in the properties for production statistics in section 7.7, then the  
statistical values will be displayed in the folder $Statistics in the database tree.  In the example below 
we have selected statistics for the signals ”MV_REG” (Real)  and ”MOTOR_TILL” (Bool). For the real 
valued signal ”MV_REG”  the Max, Min, MV and Standard deviation are calculated. 
For the logical signal”MOTOR_TILL”  the time the motor has been ”On” and ”Off” and also the number 
of switches On/Off are calculated. Note that the value TONACC shows the total running time for the 
motor since start. 
 
All the statistical data shown in $Statistics can be displayed in Picture objects on the screen. 
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Display of system data 
The folder  $System  displays a system data which are automatically generated by the FirstOp 
software. Click on $System in the information tree to display the data. 
 
The system data can be display objects in operator pictures.  
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7.12 Script 

Special computations can be done using the Script function in the signal database window. The script 
may use any signal in the database for computation and set the result into any item in the database. 
The scripts are using a simple form of normal structured basic (VBA).  
 
The scripts are organized in a Script tree which is opened by selecting  ”Script” in the menu row of the 
signal database.  In the Script tree you can create new scripts,  edit old scripts and delete a script  as is 
shown below.  

 
All scripts are given a name, in this case ”Angberakningar” (Special characters like å,ä,ö cannot be 
used). Each script is executed periodically with the time interval (msec) you specify. 
 

First double click on the  
”Script” symbol.  Then click 
with the right mouse button 
to the right to open a menu 
where you can either create, 
edit or delete a script. 
Name and cycle time is 
defined in the  specification 
window. 
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The code is according to the VBA standard.  Signal values used in the code must be given its complete 
database name.  Since the complete may be rather long,  it is simpler to  do as is indicated above, i.e. 
click with the right mouse button in the desired position and look up the signal in the database using 
the browser. A signal value in the database is identified by the syntax:  
 
Sig.Value("TK-KVVT-FB9.FB9.VA.FORMEL.ANGA_KW_EFFEKT") 

 
which is automatically generated if you use the browser.  If you want to add a value to a signal in the 
database it must be defined as”Local” in the property TagType in the section 5.3.1.  You write  
 
Sig.Value("TK-KVVT-FB9.FB9.VA.FORMEL.ANGA_akf")=afk 

 
where the signal TK-KVVT-FB9.FB9.VA.FORMEL.ANGA_akf is defined as  ”Local”  and is given the 
value of the internal variable afk. 
 
The syntax is similar if you want to send a data message to the control system from a script: 
  
Sig.Value("TK-KVVT-FB9.FB9.VA.GRP.CONT.ORD_NIVA_LIM")= a + b 
 
where  the signal TK-KVVT-FB9.FB9.VA.GRP.CONT.ORD_NIVA_LIM is defined as ”Write” and is 
assigned the value a+b.  Note that the script is executed cyclically which means that data message is 
sent repeatedly each period. If you want to avoid repeated sending, you have to surround the send 
message by a conditional  sentence (If..Then End if) for instance as: 
 
If SendCond = True then 
    Sig.Value("TK-KVVT-FB9.FB9.VA.GRP.CONT.ORD_NIVA_LIM")= a + b 
End if 
 
where the logical variable defines the sending condition.  

By marking in a position 
within the code you can get 
the total signal name from 
the database using a browser  
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8 Picture objects 

8.1 Picture editing online 

 
 
In Edit mode you can create, delete or change pictures or objects. All editing is done in the running 
station, i.e. no special system compilation is needed.  The result  is directly visible after the change is 
made.  If you are working in an active system controlling a live process, all changes should be done by 
care since any mistakes may affect the process. Changes in an active station should therefore be done 
only be done by trained personnel. 
 
Edit mod is displayed by a yellow indication at the top of the base picture. You activate Edit mode by 

selecting System → Edit images  in the menu row. You return to Normal mode by reselect  System 

→ Edit images  or (quicker) by clicking on the yellow indication at the top.  
 
Important notice: For security reasons all operator commands are blocked in Edit mode.  They are 
instantly activated when you return to Normal mode, e.g. by clicking on the yellow ”Edit mode” 
indication. 
 
It is also possible to work on another PC with the FirstOp application installed. You simply copy the 
Data folder from the active station and make the changes you want and reinstall the Data folder in the 
active station.  
 
 

 
 
 

 
 
Recommendation:  Always take a backup of the Data folder before you make large changes.  If 
problems arise, you can quickly stop the FirstOp station, reinstall the old Data folder and restart with 
the original settings. 
  

Select ”Edit images” to activate 
Edit mode 
Reselect ”Edit images” to 
deactivate Edit mode (or click on 
the yellow indication) 

Important: Always  save your 
changes when you are finished. 
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8.2 Property window 

 
All the settings in a picture are defined in a property window. The station must be in Edit mode to be 
able to open a property window.  
 
The main rule is to click with right mouse button on the picture object  and select ”Properties” to 
display its properties as in the example below: 
 

 
 
Then you make the changes you want in the property window and close it when you are finished. 
All changes are displayed as soon as the property window is closed.  
 

8.3 Creating picture objects 

Copying old objects 
Often a user has developed a certain standard for colors and graphics he wants to reuse.  It is then 
convenient to copy a similar object in another picture and paste it into the picture to be edited.  The 
procedure is as follows. 
 

• Click on the object you want to copy  with the right mouse button and select ”Copy” in the 
menu (or use Ctrl+C)  

• Go to the window where you want to reuse the object. Click with right mouse button and 
select ”Paste” in the menu (or use CTRL+V).  The pasted object is now a copy of the original 
object.  

• Then edit the object as was shown above by opening its property window, mostly only 
database connections to a measured value, an indication or an operator command. 

 
The object will now be alive and making the display that is intended. 
  

Right click on the object and select 
”Properties” from the menu. 
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Creating new objects 
 

If you want to create a completely new picture object you can either select  Edit → New object in the 
menu row or click with the right mouse button anywhere in the picture and select New object 

from the menu.  
 
A list of available picture objects will then be 
shown. As soon as you have selected an 
object, it will be placed on the screen. You can 
then move the object to its position in the 
picture and open the property window to 
specify its properties and database 
connections.  
 
Each object in the list can be used in several 
different ways which is explained below. 
 
Important remark. 

The Symbol object is an older standard which 
is kept only for compatibility with older 
installations. It is replaced by Dynamic 

Symbol.   
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At present the following picture objects are available. The object list will be expanded in projects if 
needed.  
 
Picture object Can be used for 
Label • Display of a real or an integer value, with or without display of engineering 

unit. 
• Analog send message to the control system to set a real or integer value. 
• Display of logical signals with color changes  
• Logical send message to change status in control system. 
• Any combination of those above 

Text Text for general information on the screen.  
Button Button for logical command:  

• Logical send message to change status in control  
• Display of logical value with button colors  

Symbol 

(Older 
standard) 

An older standard for process objects which is replaced by Dynamic Symbol. It is 
kept for compatible reasons with older installations. The function is described in 
Chapter 9. 

Bar Display of a measured value in the form of a bar.  
Database connection: 

• Analog value for real or integer signal 
PopUpButton Opens a PopUp window on the screen.  

Database connection: 
• PopUp picture from a list 

Status Text 

Integer 

Displays status text depending on an integer value (1,2,…, 20). A real value will be 
converted to the nearest integer value.  
Database connection: 

• Analog real or integer signal 
• Analog command to select a state in control system 

Status Text 

Logical 

Display status text depending on a logical value (True,False).  
Database connection: 

• Logical signal  
• Logical command to select state. 

Note Message window where the operator can write a message to other users in a 
network (only if a signal/file server is included).  If no signal server is present,  the 
message is only available in the local station, e.g. for other operators or as a 
reminder .  
 Database connection: None 

Frame A graphical square on the screen. No container ( see Panel below) 
Database connection: None 

ScriptButton A button that activates a script which is specified directly in the button. In the 
script you can e.g. activate a calculation or send multiple commands to the control 
system.  
Database connection: 

• Logical signal that colors the button 
Camera A picture from a WEB camera in the network is shown as a PopUp if you click on 

the symbol.  
Database connection: 

• IP-address for WEB camera 
• Logical signal that colors the WEB symbol. 
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Picture object Can be used for 
Polyfigure The object is used to display a set of measurements in a graphical form, e.g. the 

pressure distribution in a district heating network or a temperature profile in a 
furnace.  The picture object also serves as a container for other picture objects 
which can be placed within the object area to display associated information, e.g. 
alarm indications. 
Database connections: 

• Analog real or integer signals in a number of measurement points. 
FileButton Opens an external button, e.g. ”.pdf” file describing a process object.  

Database connection: 
• A path to the document 

UserGraph XY dynamical graphical display of measurements.  
Database connections: 

• Analog real or integer signal for X-value 
• Analog real or integer signal for Y-value 
• Logical signal for resetting the graph 

Panel Graphical area which works as a container for all picture objects placed in it, i.e. 
follows the area if it is moved or copied 
Database connection: none 

Arrow Graphical arrow which is displayed either fixed or flashing if a logical signal is set. 
Database connection 

• Logical signal to activate arrow display, e.g. to show rotating direction 
Image Fixed image in an accepted image format (jpg, bmp, gif, wmf).  

Database connection:none 
AliveLabel The label is colored if the value of a signal is not changed within a specified time. 

The object can be used e.g. to show if a signal communication is working using 
integer counters. 
Database connection: 

• Analog real or integer signal for Alive indication 
Dynamic graph Dynamical curve display for up to 10 signals in the database. The most recent 

values are displayed to the right and the curve will move to the left as new signal 
values are coming in.   
Database connection: 

• Analog real or integer signals (max 10) for curve display. 
Joystick Command object which works a Joystick on the screen in one or two dimensions. 

Database connection: 
• Analog real or integer signal for send message 
• Logical signal locking the joystick 

PopUpButton 

Ext 

A new popup button to be explained later. 

DynamicSymbol Selects a face plate from a symbol library created as is explained in chapter 6 
Scale The object generates a scale axis to be placed in the picture. 
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8.4 Object Label 

 

Property window 

  
 
A label can be used in different ways:  
 
Status display 

 

The status display is controlled by connected  logical signals in the 
database. The colors can be shifted in three different levels 
depending on the two logical signals controlling the color.  
 

 

Measurement display 

 

You can select if the engineering unit is to be shown or not. The 
number of decimals are selected from the database unless you 
specify differently. By using the logical signals you can change the 
background color, e.g. red at an alarm status else yellow.  

  

General graphical settings 

Color settings which can be controlled 
by logical signals in the database. 

Select type of display type from a list 

Connection of analog real or integer signals 
for display  
Connection of logical signals to set colors. 
Connection of analog real or integer order 
signal for send message 

Emergency stop 
Power on 
Normal voltage 
Power error 

Flow reg 
Pressure  
Pressure fwd 
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Value setting 

 
 

 

 
If the ”Analog order” property is connected to a ”write” signal in the 
database,  a small window is opened when you click on the label. The  
current value can be changed either by using the increase/decrease 
buttons or by typing in a new value. The new value is sent to the 
control system when you click on ”Set value” 
 
 
 
 
 
 
 

 

8.5 Object Text 

Properties             Example 
  
  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Text object is used to put explaining  information on the screen. You can specify color, font, size 
and graphical design in the property window. You mark in the ”Text” property and click on the little 
button to the right to fill in the text window that will appear, see above.   
 
 
 
  

51.6 

BV MAX 

51.0 
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8.6 Object Button 

Property window                                                          Example 
 
  

 

The Button object is used to create a logical operator 
command which is sent to the control system.  
The command signal is selected in the property 
”Boolean order”.   The button color can be changed  
by the property ”Background color L1 true” which is 
activated by the signal ”Boolean value 1” 
 
If the property ”Acknowledgement” is ”true” then  the 
command must be acknowledged by the operator 
before it is sent to the control system, see above. 

 
If ”Acknowledgement ” is ”false” the command will be sent to the control system directly when you 
click on the button. 
 

8.7 Object Symbol 

 
Properties 

This is an older standard which is not described in this 
manual.  It has now been replaced by the object 
Dynamic Symbol described below. 
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8.8 Object Bar 

Properties     Example  
                                                                                            l 
 
 
 
 
 
 
 
A bar display of a measured value.   It is possible to 
use different colors for the positive and negative 
sides. 

 

 
 
 

 

8.9 Object PopUpButton 

Properties                                                                                Example 
 
  
 
 
The object is used to open a PopUp window.  You 
specify color and text and select the PopUp window 
from a browser list. 
 If you want to be able to open the window in other 
operator windows you can simply copy the object and 
place it in the pictures where you want to open the 
window. 
In the example we will open the window BRTP_13 by 
clicking on ”Bränsletransport” (Fuel transportation) 
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8.10 Object Status text integer 

Properties               Example 
  

 
 
The object displays a status text which is controlled by 
an integer signal ”Signal” in the database. Besides the 
normal graphical settings, the user specify text strings 
Text0…Text20 corresponding to signal values  0…20. 
Typical ways to use the object is to provide information 
in a process object or explaining error codes in a field 
bus connection. 
 By the ”Analog order” property you send the actual 
integer value to the control system.  
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8.11 Object Status text Boolean 

Properties                                                                                            Example 

 
 D 
 
 
 
 
 
 

 
Displays status information based on a logic signal. Text 
for value ”1” (True) and ”0”(False) is specified.  The 
property”Boolean order” is used to send a logic 
command to the control system, e.g. to change status.  
 
 
 
 
 
 
 
 
 
 
 
 

8.12  Object Note 

Properties                                                      
Example 

 
 
The Note object is a note pad for exchanging information between the production personnel. 
In Edit mode you specify the colors ”normal” and ”urgent” determing the color of the symbol on the 
screen. If the operator opens a Note window  in normal mode, he will see the information written 
earlier and add some information of his own. Alternatively he may delete earlier notes.  If ”Important” 
is selected in the note window, the object will be colored with ”urgent color” else with the ”normal 
color”.  
 
Normally a number of such note objects  are placed in each important window for information 
exchange regarding objects seen in that window.  
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8.13  Object Frame 

Properties    Example 
 

  
 
The object generates  a graphical area which is used to organize the data display in a better way for 
the operator. 
  
Remark.  The objects placed in the area will not be kept if the area is moved.  If you want to create a 
graphical area which is also a ”container”,  i.e. keeping the objects placed  in the area at movements, 
then you should use the object Panel described below. 
 

8.14  Object ScriptButton 

Properties               Example 

 
 
The object executes  local Script program stored directly in the object. It can be used e.g. to perform a 
calculation which is stored in the local database (use property ”Local”, see signal definitions) or to 
send multiple commands to the control system.   

Graphical area 
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To define the Script program, mark the ”Script property” and click on the small button to the right to 
display the programming window:  
 

 
 
The programming syntax is the same as is defined for general scripts in section 5.9. The button color is 
determined by connecting the property ”Signal” in the database and selecting the color with 
properties  ”BackColor False”  and ”BackColor True”.  It is also possible to request operator 
confirmation  before the script is activated as in the example above.  The confirmation is defined by 
the properties”Have Acknowledge” and ”Acknowledge Text”. 
 
NOTE. The object  is only functioning in a local station and not in shared windows if the station is 
connected to a signal/file server. 
 

8.15  Object Camera 

Properties               Example 

 
 
The object displays pictures from a WEB camera connected to the network. The camera is identified 
by the property ”IP address”  where the IP address for the camera is specified. The color of the symbol 
may be controlled using a database signal ”Boolean signal 1” and the color is selected by the 
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properties  ”Background  color normal” and ”Background color L1 true”. The purpose of the color is to 
notify the operator that something has happened which means that the camera window should be 
opened. 
 
In normal mode the camera window is opened when the operator clicks on the object and remains 
opened  and visible until the operator close the window. The operator may move the camera window 
to any position on the screen where it will stay even if the picture is changed. This means that the 
operator may open several camera windows and place them e.g. in a corner to keep surveillance,  
while he is doing other things. The operator can also create a Shortcut (see section  7.6) if he wants to 
open several WEB cameras with one selection.  

8.16  Object FileButton 

Properties                            Example 

 
 
 
The object is used to open an external document which may e.g. contain a description, a drawing or 
some other documentation associated with a process.  The document is defined in the property 
”Path”  by looking up the document with a browser.  
 
In the example above, a manual for the Production Replay function is opened as a .pdf file. 
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8.17  Object PolyFigure 

Properties         Example 

 
 
A graphical display of a chain of measurements along an x-axis is generated. Typical usage is: 

• Temperature distributions in a furnace. 
• Pressure distribution in a steam flow network 
• Tilting in a rolling mill 

The purpose is to give the operator a quick overview of a process part. 

The positions of the measurement points is specified in the property ” X Points” and are fixed values . 
For each point a measurement is selected from the database in the property ”Y Points”  which is 
displayed in this point in the graph. 
 
The graph is drawn in the following way: 

• Lines are drawn between the different measurement points to show the variation in the 
distribution.  

• One line is drawn from the first to the last point to show the total trend in the measurement 
chain.  

• The area in between is colored with the property ”ForeColor”  

The object also works as a  Container,  i.e. other picture objects can be placed inside the object area   
as is illustrated in the example above where a measured value and a status display have been added.  

General setting for graphics and colors  

Number of measurements on the x axis 

Measurements (x) are fixed values (positions in the graph) 
Measurements(y) are selected from the database 
 

Signal range for  x,y in the graph 

Settings describing  the scaling the graphic curve 

Cyclic update time for graphic curve 
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8.18  Object UserGraph 

Properties         Example 

 
 
The object functions as an XY wrote where the signals x,y are taken from the database. The drawing 
goes on continuously until the RESET signal defined in the ”Reset” property is true when the drawing is 
reset. To stop the curve drawing, the RESET signal must be constantly set to ”True” (”1”).  

General settings of graphics and 
colors.  

The XY-graph is connected to signals 
in the database.  

The reset signal clears the XY-graph. 

Signal ranges for x,y values are 
specified 

Scaling in the graph 

The update time in the graph 

Engineering units  on the axis x,y 
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8.19  Object Panel 

Properties          Examples 

  
 
The Panel object is used to other picture objects in a container, i.e. all inside objects are kept in 
positions when the panel is moved or copied.  The purpose is to group information which is associated 
to each other, which makes the picture construction easier.   
 
Remark. Note the difference of the object Frame which is used in a similar way, but is no container. 
 

8.20  Object Arrow 

Properties        Example 
 
 
The object shows an arrow which is controlled by a 
logic (boolean) signal.  The arrow will be visible only if 
the logic signal have the value ”1”  (”True”) else 
invisible. Typical use is to display of the moving 
direction in a rotating machine or a flow direction in a 
pipe.  
 
The logical signal is taken from the database in the 
property  ”Value”. The direction of the arrow is 
selected in the property ”Orientation” (Left, Right, Up, 
Down)   and the type of display in property  ”Arrow 

Type” (Static, Flashing). 
 
Remark. By placing arrows on top of each other you can illustrate different directions and graphical 
effects, e.g. ”Flashing” at low speed and ”Static” a high speed. The logics are easily handled in a Script. 
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8.21 Object Image 

Properties                        Example 
 
 
 
 
 
A static image is selected using a browser in the 
”Picture” property to be displayed in the picture. 
Accepted formats are: jpg,  bmp, gif, wmf, emf 
 
 
 

8.22 Object AliveLabel 

Properties                Example 
 
 
 
The object is checking a clock signal (Integer or 
Real)0,1,2…which is generated by a unit and  sent to 
the station. The unit is assumed to be alive if a change 
in the clock signal is detected within a specified time, 
otherwise the unit is assumed to be stopped.. 
 
The clock signal is selected from the database in the 
property ”Value check change” and the timeout is 
specified in the property  ”Timeout time [s]”as a fixed 
value. The display colors are defined by  ”Background 
color OK” and ”Background color timeout”. 
 
The logical alive signal created can be written into the 
database by the property ”Value error”.  
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8.23 Object DynamicGraph 

Properties                       Example 

   
 
The Dynamic  graph is frequently  used to place powerful graphical displays anywhere on the screen. 
The object generates a multi-graph with up to 10 different curves which are updated continuously 
inside the same graph. The signal values enter from the right and disappear to the left. 

First read the section ”How to use the DynGraph”below in order to get an idea of how the graph is 
used before you read ”Graphical settings below” 

 

How to use the DynGraph 
Below is a short description of the most important functions in the graph.  
 

Reading signal values. 

 
Normally the latest signal values are shown at the graph head.You 
can also read the signal values at a specific point by marking in the 
graph with the left mouse button pressed. All the signal values in 
this point are then shown in the graph head. The graph is frozen as 
long as you keep the mouse button pressed, but will then go on as 
before. 
. 
 
 
 
 
 

  

Mark the point and keep the left mouse 
button pressed 

Read the signal values 
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Zoom function 

You can enlarge a specific area in the 
graph by marking the area with the 
right mouse button pressed as is shown 
in the example.  
 
The graph display is then temporarily 
stopped so that you will have time to 
analyze the enlarged area. You 
deactivate the zoom function by 
clicking with the right mouse button 
anywhere in the graph, and the graph 
goes on as before.  
 
No data is lost since the normal 
operation is always running in the 
background.  
 
 

 
Historical values 

Older values no longer visible in the 
graph can be scrolled back by marking 
in the square ”Hist”in the lower right 
corner.  Use the scroll bar at the 
bottom to go backwards and forwards 
in the graph. The number of data kept 
in memory is defined in the general 
settings. 
You return to normal display by 
deactivating ”Hist”. 

Note that this object is intended for on-line use by the operator.  The inside contents of the graph is 
stored on file if you close the station and retrieved when you start up again. 
For historical storage of data read section 7.7 ”Production statistics” and  chaper 11  “Production 
Replay”. 

  

Mark an area with the right 
mouse button pressed 

Click anywhere in the area 
with the right mouse button 
to return to normal view  
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Graphical settings 

Click in the property ”Graf setting” to open a definition window with four tabs : 

Tab 1: General 

 
You define general properties valid for all curves.: 

• You may have any backcolor in your graphs which should match the selections of grids and 
texts. 

• You may have up to 6 multigraphs each containing up to 10 curves within the picture object  
• You can select date/time on the time axis. 
• You define the number of data points kept in memory (”Max points”) and the data sample 

time (”Data sample time[ms]”).  In the example above we will have 2000 points with 0.1 ms 
reading, i.e. a total internal history of 200 sec with resolution 0.1 msec in this example. 

• The ”Graf update interval” defines how often the curves are updated in the screen display. In 
the example, the curve is updated each 0.3 sec. 

• The ”Font” property defines the format for all texts in the curves 
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Tab 2: Grid 

 
You define;. 

• The major and minor divisions for the X and Y axises 
• The color of the grids which should match the background color defined in the preceding tab 

(white background in this example). 
• The color of the X and Y axis showing the scale. 
• The total time range displayed in the X axis ”X-axis width” expressed in the unit selected from 

a list. In the example above the total time range displayed is thus 2 minutes. Note that the 
graph will keep a larger internal memory defined in the general settings and retrieved using 
the ”Hist” button in the graph. 

 
Use the ”Apply”  button to visualize the color selection you have made without exiting the object 
setup. 
 

Tab 3: Curve colors 

 
The colors of the different colors are defined. In this example the curve colors are selected to be 
clearly seen with the white background we have selected. 
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Tab 3: Curve settings 

 
In this tab you connect the graph to the database: 

• Select the ”Group number” and the ”Curve number” you want to connect to the database. 
The object may contain up to 6 groups each one containing up to 10 curves. The groups  are 
displayed below each other in the object area.  

• Connect the ”Tagname” selected in  the database using the browser. The description is 
automatically copied from the database. 

• The signal is scaled relative to 0-100%  (”Max”, ”Min”) which represents the full graph span 
used by all curves. In this example the value ”80” will be at the top of the graph and the value 
”0” at the bottom of the graph. 

• The number of decimals shown in the value display is defined.  
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8.24 Object Joystick 

Properties                   Examples 
 
 
 
 
 
 
 
   Joystick   
 
The Joystick object is used to manually operate a 
process object in one or two dimensions. The operator 
grabs the knob with the left mouse button pressed to 
a point within the object area. The X  and Y values are 
sent continuously during the movement to the control 
system.  When the operator quits the left mouse 
button,  the knob will return to its base position.  
 
 
Warning. The picture object Joystick will generate 
rapid cyclic send messages and therefore the ”Events” 
property in section 7.8  should not be activated for 
signals used by the Joystick object since the event list 
will be filled up. The function should be activated only 
for send messages which are not repeated 
automatically such as e.g. operator commands.  
 

Settings 

• The position values are sent to the control system as send messages  ”XOrder” for X position 
and ”YOrder” for Y position which are connected to the database using the browser. The 
values are sent cyclic to the control system with the time interval ”OrderSendInterval[ms]” as 
long as the left mouse button is pressed. The items in the database should be defined as 
”Write” or ”Read/write” in the ”Client Access” property, see section  7.4. 

• Starting point is the point the knob will return to when manual operation is ended by 
unpressing the left mouse button. 

• The operating surface is defined by the size of the object on the screen, e.g. by dragging the 
corner points or by specifying the size properties (” XLeft, XRight, YTop, YBottom” ) which 
defines the area limits in the X or Y direction. The operation area may either have a fixed color 
(” BackgroundColor” ) or be an image (”BackgroundPicture”) selected using the browser. 

• The operator knob is made with a preprepared image when you create the object. If you want 
to change the image or remove it you use the property ”KnobPicture”. In case there is no 
image selected, the operator knob will be a square with color defined by ”KnobColor”.  The 
size of the operator knob is defined as a percentage of the total width and height 
(”KnobWidthPercent” and ”KnobHeightPercent”. 

• Operation lock  is controlled by the signal ”Locked” which is connected to the database. If the 
lock signal is true (=1) then the operator knob cannot be moved. 
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8.25  Object Dynamic symbol 

. 
 

 
 
The object contains a library of face plates used to interface specific process objects. 
Here you connect the symbol to the folder holding the data  ”EEB22 AF016” using the browser. Also  
select one of the popup windows ” MOTOR-OP” which you select using the browser. 
 
See  Chaper 6 for more details and how a symbol library is constructed. 

 

8.26 Object PopUpExt 
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8.27 Object Scale 

 
 
Displays a vertical scale on the screen. 
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8.28 System status indicators 

 
If you activate ”Edit mode” there will be a row of status indicators shown at the very top. The purpose 
is to give the operator an overview of the complete system where the green color means ”OK” and the 
red color means ”not OK”.  

 
Scada system indicators 

The indicators to the left are reserved for connected servers in a Scada network.  The Scada indicators 
are automatically activated by the  Communication settings in section 12.2.  Inside each activated 
indicator there will be a small identifying text as is shown in the example above: 
 
Text Reference  

F1 File server 1 
F2 File server 2 
S1 Signal server 1 
S2 Signal server 2 
A Alarm server 
 
 
Programmable indicators 

The remaining indicators can be connected to any logical signal in the database. Just click on the box 
and identify the signal using the browser. Value ”1” (True) means green color and value ”0” (False) 
means red color.  By placing the mouse pointer at the box, you can identify which signal is used:  
 

 
When you return to Normal mode, only the defined status indicators will be shown. 
  

Point at the indicator for identification 
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8.29  Format drawings  

Move and resize the object 
Picture objects can be moved and resized as is shown below:  

Formatting a collection of objects 
In each window (Picture) there is a Format menu which is used to format a collection of objects.’ 
 

 
 
The procedure is 

• Draw a square around the objects that is to be edited by the left mouse button pressed. A 
number of objects are then selected when you release the mouse button. Then click on one 
object which is to be reference.  Select one option from the Format menu to do the correction 
you want. 

 
Example: Four label objects are to be put in row vertically: 
 

 
  

Enlarge or reduce the object 
size by dragging the corner 
points. Move the object to a 
desired position with the left 
mouse button pressed.  

Mark the objects involved and select 
the reference object (at the bottom) 

Select ”Align”+”Lefts” 
from the Format menu 
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9 Using operator pictures 

9.1 Picture groups and base pictures  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The base pictures are assembled into groups shown at the bottom of the screen.  You select a group 
and all the base pictures within the group will appear in the second row. 
 
All base pictures have a  standard layout with a fixed part which is the same for all pictures and a free 
part which is constructed by the user. The free part will be the only part exchanged when you change 
picture. 
 
The fixed parts shown at all pages are 
 

• Menu row at the top for various settings, editings, displays etc.  
• Information row with system indicators. 
• Alarm message which shows the last unacknowledged alarm. If the operator wants more 

information he may click on the button ”Alarm list”. 
• Acknowledge of the latest  alarm message by clicking on ”Ala. ack” 
• Acknowledge of an alarm noise by clicking on ”Aud ack”.  
• Closing all open PopUp windows by clicking on ”Close Pop” 
• Closing all open operator commands by clicking on ”Close man” 

System status Menu row Last unacknowledged alarm 

Noise ackn 

Alarm ackn 

Close all 
commands 

Close all 
Popups 

Select group Select picture 

Yellow=edit mode Picture layer level 
nivå 

Show alarm list 

Process area freely 
designed by the user 

Select operator trends 
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• Selecting Picture Group  by clicking on the bottom row or press the character shown on the 
keyboard. 

• Selecting Picture  within the group  by clicking on the second  row or press the character 
shown on the keyboard. 

 
A picture change can thus be done in three different ways: 
 

• Clicking on the buttons at the bottom. 
• Pressing the character within the parenthesis  (.)on the keyboard 
• Selecting the picture from the Process menu: 

 
 

  
 
 
In addition to process pictures specific for the application, there are two standard groups with a fixed 
layout:  
 

• Trend  where the operator can define up to 320 graphical curves  on-line which are 
continuously updated in the background even if not always visible. They are used as an 
operator tool and is a complement to the ”DynGraf” object  described above, which has a 
fixed design for a specific page. 

• Regulators which is an older standard which is only kept for compatibility with older 
installations. It is not described here. 

 

REMARK. Regulators are today normally placed in the process pictures where they belong.  Since all 
Face plates and PopUp pictures stay in position also when the process picture changes, the operator 
can select some he is working with for the moment and place them in a suitable position on the 
screen.  They are then always accessible also if the process picture is changed. 
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9.2 Using standard trend curves 

 
 
 

 
 
 
Description 

The Trend group is a special group of base picture with a fixed layout as is shown above. It is a tool for 
the operator to assemble the signals he wants to see in suitable groups. The graphs can be created 
and edited on-line during normal operation. The DynGraf object described above is similar, but is part 
of a design in a specific page and cannot be changed during normal operation. Normally you specify 
the graph to cover between 10 min and 2 days depending on the process.  The time resolution is 
normally selected from about 100 msec to 10 sec.  You can define up to 20 groups each containing up 
to 16 curves divided in two multigraphs as is shown above, i.e. a total of 320 curves, The curves are 
updated continuously even if they are not seen on the screen which means that a picture change is 
almost immediate since the data is stored inside the object. 
 
Special functions. 

The special functions are the same as for the DynamicGraph object : 
 

• The signal values at a certain point are read by marking in the point with the left mouse button 
pressed. The signal values will be shown in the graph head.  

• Zooming. Mark the desired area with the right mouse button presses. The graph will then be 
stopped and selected area covers the whole graph area. To return to the original graph just 
click anywhere in the graph area with the right mouse button 

• Historical values. If you want to look at older values outside the graph area, click on ”Old 
values” in the lower right corner and use the scrollbar to move the curve backwards and 
forwards.  

 
See also ”How to use DynamicGraph” in section 8.23.  
  

Select trend group Edit groups and curves 

Show old 
values 
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Settings in trend graphs 

To change the graph or create a new graph click on ”Edit mode” . You end the editing by clicking on 
”Edit mode” again.  
 

The setting is very easy and can be performed by the operator at any time. All curve design is made in 
the running system and the curve is active as soon as you leave edit mode. 
 
 
 
 

 
 
 
  

Set trend in edit mode Select signals  

Click to select new 
signals from 
database  

Specify the time 
resolution in msec 

Save the new curve 
setup 

Specify the values 
for upper and lower 
limit in graph 

Select the length of the 
graph from a list  

Create a new group 
and specify its name 



 Manual FirstOpNet Doc.Id: 1712-1/GB Dat: 2017-12-01 

  

 

 

FirstOpManual-Eng01.docx www.firstcontrol.se Sida: 97 (115) 

 

9.3  Using PopUp pictures 

 
 
PopUp windows are operator pictures with a configurable size which are activated by a button 
(object ”PopUpButton”) in another window.  A PopUp window is placed on top of the base 
window and can be moved to an arbitrary position on the screen. PopUp windows are always 
placed in the foreground and remains there also if the base picture is changed, i.e. it is not 
possible that a PopUp window ”disappears” behind another window.  
 
There is no theoretical limit on the number of PopUps used  in a FirstOp station and an arbitrary 
number of PopUps may be activated at the same time. You can also build PopUps in several levels, 
i.e. PopUps are opened from other PopUps.  
 
A single PopUp is closed by clicking on the ”x” square in the upper right corner of the window. 
 
If it becomes too messy, you can always close all activated PopUps by clicking on the button ”Close 
Pop” in the upper right corner of the screen. 
 
Some different ways to use PopUp windows: 
 
1. As an operation windows to control special sequences and process objects.  
2. As a process picture describing the details in a specific part of a larger process picture . 
3. As a FacePlate (DynamicObject), a special type of standardized PopUp where the same layout  

is used for objects of the same type, e.g. a regulator, electrical motor, pump, valve, pump etc. 
  

PopUp for a startup sequence Popup as an additional Base Picture 
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9.4 Displaying object connections 

 
If you place the mouse pointer on any picture object which is connected to the database, the signal 
identity is displayed. Example:  
 

 
 
The complete path in the database tree  and the signal description is shown. The different levels in the 
database tree are separated by a dot (.). 
 
If several database connections are defined in a picture object, it will by default display the first active 
connection in the property window.  

9.5 Operator commands to control system 

Logical commands 

Logical commands is normally handled by a button in a process picture or in an object which is 
connected to a ”Boolean order”. The result of the command is often shown as a color setting of the 
button or by some indications nearby.  Most logical orders used in a system are direct, i.e. they will be 
sent to the control system as soon as you click on the button. If the command is sensitive, you may 
request a confirmation from the operator before the command is activated as in the example below.  
 
Example. 

  
 
 
 
 
 
 
In this example we request a confirmation of the logical command by setting the property 
”Acknowledgement”  to ”True”. The command will then not be sent until the operator click on ”OK” in 
the confirmation window.  In this case we will color the button green if the read back signal ”Boolean 
value 1” is true. 
 
Real commands 

Click on the value you want to change.   If the object is connected to a signal defined as ”Write” or 
”Read/Write” a small command PopUp will be opened. You can either type the new value on the 
keyboard or use the increase/decrease buttons shown in the PopUp. When you click on ”OK” the new 
value is sent to the control system. 
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Example: 

 
 
 
 
 
In this example we are using a Label object. The send message is connected to ”Analog order” and the 
display message to ”Analog  value” which displays the actual value in the control system. In this case 
the signal is defined as ”Read/Write” which means that the same signal can be used for the send and 
display message.  

9.6 Shortcuts 

The operator may create a shortcut link to PopUps needed for a specific purpose, e.g.  supervising a 
startup sequence or a specific subprocess. Using the short cut  he can open all the PopUps with a 
single selection. 

 
To create a PopUp shortcut 
do the following: 
 
Open and place the PopUp 
windows you want to open 
on the screen.  
Then select ”Save as PopUp” 
from the menu ”Shortcut 
control”. A small definition 
window is shown and you 
specify the name of the 
shortcut, ”MANUAL TEST” in 
this case. 

 
The shortcut  can be used irrespective of what page is open just now.  Open the shortcuts you just 
created by selecting”MANUAL TEST” in the menu. If you have several shortcuts they will be displayed 
beneath each other. 
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9.7 Layers with added information 

Each base picture may contain tree different layers (0, 1, 2) with added information. The layer for a 
specific Picture object is defined in its properties where the default layer is ”0”, i.e. the base layer. The 
other layers (1,2) are added to the display of the base layer ”0”.  
 
The operator change the layer by the buttons ”Page up” and ”Page down” on the keyboard.. 
In the example below some information from the electrical drawings is displayed for the operator in 
the second level. 

 
. 
 
  

Layer 0 Layer 0 +1 

Page Up  
 
Page Down 
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10  How to use process alarms 

10.1 Alarm list 

Click on the ”Alarm list” button on the menu row to get the whole alarm history.   
 

 
The following information is shown from left to right: 
 

• Present status (acknowledged, unacknowledged, active, not active) 
• Time when the alarm occurred 
• The alarm priority (A,B,C,D,E) 
• Description including value for analog alarms 
• The group where the alarm happened  
• Time when acknowledged 
• Time when became inactive 
• References to the signal database to the right (scroll the window) 

 
The symbols in the left column give a quick overview of the status: 
 

  
 
 
 
 

• Active and not acknowledged 
• No longer active but never acknowledged 
• Active and acknowledged  
• Not active and acknowledged 
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10.2 Alarm filters 

 
You may filter the alarm display by the following selections: 
 

1. Status: All, Unacknowledged,  Remaining, Acknowledged 
2. Period: All, Current hour, Current day, Current week, Current month 
3. Unit priority:  Alarms down to A,B,C,D,E levels 

 
If you are connected to an alarm server (optional) then you can view all the other alarms generated in 
the network by the selections Computer, Group. If you have a stand-alone station you can only find 
your own application in ”Group” 
 
 

10.3 Acknowledging and blocking alarms 

If you click on a specific alarm event with the right mouse button the following popup menu is shown: 
 

 
 
The menu selections are: 
  
Ack Acknowledge the alarm you clicked on 
Ack all Acknowledge all alarms that has not been acknowledged before 
Block Block this alarm  
Block group Block all alarms in the same group as the selected signal 
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If you are blocking alarms, you get a popup window where you specify how long the alarm is to be 
blocked. The action is not accepted until you add a signature: 
 

 
 
Select Show->Blocked alarms in the menu row to display all alarm events which are currently blocked: 

 
 

10.4  Operator events 

By selecting ”View events” in the alarm list head, all operator commands will be inserted into list of 
alarm events in the order they appear, see the example below.  All operator commands are colored 
green operator. The purpose is to identify a chain of events which may cause a specific alarm. 
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11 Production replay 

11.1 Functional description 

The production replay function stores the whole signal database continuously into local log files in 
high time resolution down to about 30 msec as long as it is activated.  
A typical curve display which is taken from a cold rolling mill is shown below.  
 

 
Fig 1: Display of cold rolling in four passes in a rolling mill. 
 
The log files are compressed in order to save space on the disc. Typically, a database of 600 signals and 
50 msec storage will occupy about 15 Mbyte/hour.  
 
The purpose is to  provide a tool that can be used afterwards for detailed analysis of production 
events even several months after they happened. The  production replay can run very fast, down to 
about 10 msec, which means that all events in normal production will be covered. Since all signal 
values in the local signal database  are saved continuously, it is not necessary to know beforehand 
what signals are needed to analyze a specific situation. The update rate will then be limited only by 
the communication rate between the control system and the client, which in First Control’s case can 
be made down to 5-10 msec if necessary. 
 

• TimeLog Client is a separate software package which is installed on any PC. The TimeLog Client  
is used to unpack the stored log files and show signal data in a curve display window. The data 
can be analyzed in high resolution down to msec several months afterwards.  See the TimeLog 

manual for more details. 
 

 
 
 
 
 
 
 

Use the zoom tool to 
analyse a special area 
in detail 
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11.2  Settings 

You must configure the FirstOp client for the Production Replay package. In the System menu you 
enter the TimeLog Setup. 
 

  
 
 
In the setup menu you specify.  
 
On Click to activate the data storage which may be continuous or 

controlled by the trigg signals described below. If no trigg signal is 
specified, the data storage will be running as long as it is activated. 

Log time 

interval[ms] 

The time interval for database storage is defined. A copy of the whole 
database will thus be added to the file each 100 msec in the example. 

Max file size[kB] The maximum file size. If the maximum file size is exceeded, the data 
storage will continue in a new log file as long as it is active. 

Trigg signal Click on the button to open the database window. 
The trigg signal is used to divide the storage file into suitable parts and 
to avoid filling up the disc with useless data. Any logical signal in the 
database can be used as a trigg signal. The trigg signal can e.g. be a 
logical signal indicating that the process is in operation or be configured 
to be started/stopped from a button on the screen by the operator. A 
new storage run starts when the trigg signal turns “True” and ends 
when the trigg signal turns “False”. 
If no trigg signal is defined, the data storage is controlled by the On 
property only. 

Index 1, Index 2 Click on the buttons to open the database window. 
The index signals will be put in front of the date and time in the file 
name as an identifier. Typically, the index can be a production code or 
simply an input from the operator on the screen. The purpose is to 
make it easier for the user to find the specific file he is looking for. 
If no index signal is defined, the file name will only consist of a time 
stamp date/ time. 
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11.3 Log files 

An example of log files is shown below taken from a cold rolling mill application. The log files are 
stored locally in you r PC and is unpacked with the Timelog tool 
 

 
 
The log files are text files which are time stamped. In case index 1,2 are defined in the settings, the 
time stamp is preceded  by the index 1 and/or  index 2 whichever is specified. 
 

11.4 Export to Excel files 

With the TimeLog tool you can export any of the curves into a MS Excel format as is shown below. In 
this case we have exported the curves to the left which are saved with 100 msec resolution into a  MS 
Excel format . Since you have the whole history saved in the logfiles, you can make any analysis 
afterwards.  See the TimeLog manual for more details. 

 

 
 
Remark: Due to high time resolution above, there will be about 7000 values exported. 
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12 System settings 

In the System menu  you do general settings and selections as is defined below. 
 

 
 
Some of the submenus are described in other sections of this manual are described in other sections: 

• Signal database (Chapter 7) 
• Edit Images (Chapter 5) 
• Exit FirstOpNet (Section 4.3) 

The remaining submenus are described below. 
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12.1 Application settings 

 

 
 
Some basic properties that affects the function and handling of the operator station are defined.  
 
Define symbol library This is an older standard which is no longer used but remains 

for compatibility reasons.  

Dynamic symbol designer Defining FacePlates using the DynamicSymbol object, see ch.6 
Display settings Defines screen settings, see 3.6 
Define events Is today replaced by the MS Excel export function in TimeLog, 

see ch 11. 
Security Setting passwords and other security items. 
Application settings Defining warning limits on memory usage and colors of not 

updated picture objects. 
Settings of FirstOp Logger Selections of errors to be included in a local system log file. 

Only used for analyzing the reason for system errors.  
Automatic image change Base pictures are changed automatically in a fixed order and 

time as specified in the definition window. The function can 
e.g. be used for automatic demonstrations. 

File logging Is today replaced by the MS Excel export function in TimeLog, 
see ch 11a. 

Timelog Activate/deactivate replay function which saves the whole 
database to local files in high time resolution. The function can 
be started by a trigg signal in the database. See ch 11  for more 
details. 

Systeminfo Older display of system data. No longer used. 
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12.2 Communication settings in a scada network 

The communication setting describes all the communications in a Scada Network. 
 

Signal server 

 
The local operator client is connected to  ”Signal Server 1” which is the admin server   and ”Signal 
server 2” which is the backup server which automatically takes over if the main server is stopped. As 
soon as the IP addresses are specified, the local client and the server is connected to each other in a 
few seconds which means that the client is a part of a Scada network. 
 
Setting Description 

Host IP address to host 
Port Nr. Source Port nr in TCPI protocol  which is preset and  should normally not 

changed.  
Port Nr. Client Port nr in TCPI protocol  which is preset and  should normally not 

changed. 
Enable as Source The local operator station is allowed to be a data source for other 

clients in the network. 
Enable as Client The local operator station may use signals from other stations in the 

network. 
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FileServer 

  
 
The file server keeps track of all operator windows in the network and distributes all changes made to 
a specific window automatically. The local station is connected to file server ”File Server 2” in a few 
seconds after the IP address is specified and may share windows  with all other stations connected to 
the same network.  
 
Setting Description 

Host IP address to File server 
Port Nr. Port nr in TCPI protocol which is preset and is normally not changed.   
Chk.Interval[10ms] Time interval for distribution of changes in a window to all other 

stations which share the window.  
Enabled Connection to File server is activated. 
Mess.log. priority Definition of the  logging of  error events. The setting is preset and is 

used only for error tracking.  
Automatic backup when 

saving objects. 

Backup of the station is to be saved  when the station is changed.   

Auto Backup folder Place where automatic backups are saved  
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 Logging/daybook  

 
 
In this tab general settings are made for: 

• Statistical logging (SPC) . The  SPC calculations are activated  in the database setting,  see 
section  5.3.6 for details 

• The electronic dairy is an optional  report function connected to an SQL server. It can be 
included in an operator station or be used independently. 

 
Settings Description 

SPC Calc interval Cycle time for the local statistical calculations (SPC) for both logical 
and real signal values, see section 7.7 for details. 

File Interval absolute Time 

(min) 

How often the SP values are transferred to an SQL server in case one 
exists. Computed statistical values are stored on local files until 
transfer to an SQL server can be made.  

Keep local backup(days) Number of days statistical data is stored locally in case there is no 
contact with the SQL server.  

Use validity in log file - 
IP address SQL s logging IP address to production  database (optional). 
IP address SQL daybook 

server  

IP address to dairy database (optional).  
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Alarm/Event server 
 

 
 
FirstOp can be complemented by a central Alarm/Event server, where all alarms and operator events 
in a Scada network can be stored .  
 
Data Description 

Host Alarm/Event server IP address to central SQL server handling alarm/event storage in a 
scada network. 

Port Nr Source Port nr in TCPI protocol which is preset and should not be changed- 
Port Nr Client Port nr in TCPI protocol which is preset and should not be changed,  
Enable as Source - 
Enable as Client - 
Sync Time with server -  
Save remote events to file - 
Host Alarm/event logger IP address local logger 
Port Nr Port nr in TCPI protocol which is preset and should not be changed. 
Check interval - 
Enabled - 
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Advanced settings signal servers 

 
 
All the configuration data is preset and should normally not be changed. 
 

OPC server 
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12.3 Backup 

 
 
Backup of the local operator station may be done during running: 
 

• Complete. A complete copy of the whole  Data folder including all the program files is stored. 
• Only Data Folder.  Only the Data folder which includes all configuration data and operator 

pictures is copied. 
  

The place of storage is defined in the browser shown when the  selection is made.  
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12.4 Password protection 

 
 
 
The password protection is activated as soon as a 
password is specified. Then  ”Log in”/”Log out” 
appears in the system menu and all menu selections 
which may affect the station setup is deactivated 
(dimmed) in the menu. 
 
Important notice: Be sure to remember your 
password! 
 
 

12.5 Other system submenus 

 
• Signal server  

Is used for manual checking of connections to servers.  Only to be used by trained personnel.. 
 

• Print page 

Current page in the station is sent to a printer. 
 

• About  FirstOpNet 

Current version of the operator station 

 

• Updating applications to Server. 

Is used to update the local station to the file server.  
 
 
 


